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ABSTRACT

Applicant Tracking Systems (ATS) have become integral to modern recruitment processes, yet
their tendency to systematically reject qualified candidates through over-filtering remains a
critical concern. This study investigated the prevalence, causes, and impact of false rejection in
ATS using a dataset of 600 organizations, of which 443 had adopted ATS technology. Statistical
analysis using IBM SPSS Statistics (Version 29) revealed that over-filtering affects 70.4% of
ATS users, compromising candidate selection in approximately 52% of all organizations
surveyed. The analysis identified cultural bias in language processing (11.9%) and educational
background over-filtering (10.6%) as the leading causes of false rejection, followed by industry-
specific terminology barriers (6.8%) and resume parsing formatting issues (6.5%). Notably,
while 100% of organizations experiencing bias implemented mitigation measures, none reported
successful elimination of bias, indicating that over-filtering represents a persistent structural
feature rather than a correctable implementation flaw. Comparative severity analysis revealed
that high-intensity biases requiring algorithmic reengineering, particularly cultural and
demographic biases demonstrated the strongest resistance to remediation despite intensive
intervention. The study concludes that achieving fair candidate selection requires fundamental
redesign of ATS architecture with fairness as a core principle, moving beyond procedural
adjustments toward culturally competent Natural Language Processing engines, transparent

auditable algorithms, and meaningful human oversight at critical screening stages.

Keywords: Applicant Tracking Systems, false rejection, over-filtering, algorithmic bias,

recruitment technology, candidate screening, cultural bias, resume parsing.



CHAPTER ONE

INTRODUCTION

1.0. Background of the study

The evolution of Applicant Tracking Systems (ATS) reveals a continual challenge: the systemic
false rejection of qualified candidates during initial screening. Early ATS platforms (pre-2020)
relied on rigid keyword matching and basic parsing algorithms, which Suraj, Kumari, and
Chandran (2019) identified as primary cause of over-filtering. Their research documented how
40% of parsing failures originated from non-standard resume formats (e.g., tables, graphics),
while keyword mismatches (such as a candidate describing "budget management" versus a job
requirement for "financial stewardship") prematurely removed skilled applicants. This technical
limitation forced recruiters into manual reviews, extending hiring cycles by 30-50% and

reducing organizational efficiency.

By 2023, Wijesinghe and Kawya empirically linked false rejections to employer branding
reduction particularly in Small and Medium Enterprises (SMEs). Surveying 413 job seekers, they
found that 68% associated automated ATS rejections with "faceless" employers, damaging
perceptions of organizational trustworthiness. Interviews with 23 SME managers highlighted a
contradiction: while ATS reduced initial screening time by 45%, its high false rejection rate
necessitated re-advertising roles, increasing costs by 28%. The study argued that ATS algorithms
prioritizing lexical keyword density over contextual skill alignment inadvertently signaled

"organizational strictness" to candidates, undermining competitive talent acquisition.



Advancements in Machine Learning (ML) and Natural Language Processing (NLP) emerged as
countermeasures. An integration of NLP with K-Nearest Neighbors (KNN) models was made to
parse unstructured resumes into structured data, improving skill-matching accuracy by 22%.
However, their system still struggled with semantic equivalence (contextually identical terms
like "Python programming" versus "coding in Python" were treated as mismatches due to lexical
differences). Computational inefficiency also plagued the model, with processing times
increasing exponentially for datasets exceeding 10,000 resumes, forcing trade-offs between

accuracy and scalability (Chavan et al., 2024).

Concurrently, Sathyapriya et al. (2025) deployed an ensemble CatBoost model to classify
candidates into suitability tiers ("Highly Suitable," "Moderately Suitable," "Unsuitable"). By
combining NLP-extracted features (skills, experience duration) with job description alignment
scores, the system achieved 92.8% accuracy. Yet domain-specific errors persisted: precision
dropped to 86% in Education roles due to overlapping terminologies (e.g., "teaching" versus
"curriculum development"), while highly technical fields like Mechanical Engineering saw 15%
of qualified candidates misclassified. This revealed that contextual difference remained a critical

unsolved bottleneck.

The most significant leap came with transformer-based embedding models. Bevara et al. (2025)
introduced Resume2Vec, leveraging architectures like BERT and Llama to generate semantic
embeddings of resumes and job descriptions. Their framework reduced false rejections by
15.85% in technical domains by capturing contextual relationships—for instance, associating
"CAD design" with "technical drafting" despite lexical disparities. Resume2Vec outperformed
traditional ATS in Ranked Biased Overlap (RBO) alignment with human evaluators across five

domains, demonstrating 15.94% higher consistency in Health and Fitness roles. Nevertheless,
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traditional ATS maintained marginal advantages in keyword-centric fields like Software Testing,

proving that domain-specific optimization remains essential.

1.1. Statement of problem

There are several causes of rejection of qualified candidates in Applicant Tracking Systems
(ATS). Over-filtering has been highlighted as the major reason for the rejection of qualified
candidates. ATS frequently over-filter qualified candidates during initial screening. Strict
keyword matching, inflexible requirement thresholds and parsing inaccuracies cause the system
to over-filter applicants who possess the necessary skills and experience for the role. These
results in qualified candidates being prematurely filtered out before human review, harming

talent acquisition effectiveness efforts.

1.2. Aim and Objectives

Aim
The aim of this study is to reduce false rejections of qualified candidates in Applicant Tracking

Systems.

Objectives

1. To examine the causes of false rejections in Applicant Tracking Systems (ATS).

1. To assess the effects of over-filtering on the overall candidate selection process.



1.3. Research questions

This study seeks to answer the following questions:

1l.

1il.

What are the main reasons Applicant Tracking Systems (ATS) wrongly reject qualified

candidates?
How does automatic rejection of good candidates (over-filtering) negatively impact the
hiring process?

How effective are non-technical methods (like better job ads, resume tips for candidates,
or recruiter training) at reducing ATS false rejections caused by keywords and

formatting?

1.4. Significance of the study

This research holds significant importance for multiple stakeholders affected by ATS false

rejections:

1.

It directly addresses the costly problem of missing highly qualified talent due to
technical screening errors. Reducing false rejections leads to stronger candidate pools,
better quality hires, reduced time-to-fill, and lower costs associated with prolonged

vacancies and re-hiring (Wijesinghe and Kawya, 2023).

It promotes fairness by reducing the likelihood that qualified individuals are excluded
purely due to vocabulary choice or resume design. Improves the candidate experience by
ensuring applications are assessed on substance over form, increasing trust in the hiring

process. (Suraj, Kumari and Chandran, 2019).



3. It provides critical user feedback on specific pain points (keyword rigidity, parsing
fragility). Identifies high-value areas for improving existing features (e.g., more robust
parsing, smarter semantic matching) and developing new ones (e.g., advanced
formatting diagnostics), enhancing product competitiveness and value (Wijesinghe and

Kawya, 2023).

4. It provides critical user feedback on specific pain points (keyword rigidity, parsing
fragility). Identifies high-value areas for improving existing features (e.g., more robust
parsing, smarter semantic matching) and developing new ones (e.g., advanced
formatting diagnostics), enhancing product competitiveness and value (Bevara et al.,

2025).

1.5. Scope of the study

The study is strictly confined to the problem of false rejections occurring during the initial
automated screening stage of ATS. It specifically targets rejections caused by keyword/semantic
mismatches (e.g., synonyms, contextual differences, lack of semantic understanding) and

technical failures in resume/CV parsing due to formatting and layout issues.

1.6. Definition of terms
1. False Rejection: The error-filled automated removal of qualified candidates during initial
ATS screening due to technical limitations (e.g., keyword mismatches, parsing failures),
preventing their advancement to human review (Suraj, Kumari, and Chandran, 2019;

Bevara et al., 2025).



Over-Filtering: Excessive or inaccurate ATS candidate elimination resulting in a
shortlist that excludes significant numbers of qualified applicants (Suraj et al., 2019;
Wijesinghe and Kawya, 2023).

. Keyword Matching: An ATS screening methodology that prioritizes exact lexical
correspondence between resume text and predefined job description keywords, often
disregarding contextual equivalence (Suraj et al., 2019; Sathyapriya et al., 2025).

. Resume Parsing: Automated extraction of unstructured data (skills, experience,
qualifications) from resumes into machine-readable formats; prone to failure with non-
standard layouts (e.g., tables, graphics) (Chavan et al., 2024).

Semantic Gap: Disconnect between contextual meaning in candidate materials (e.g.,
"budget management") and rigid ATS keyword requirements (e.g., "financial
stewardship"), leading to false rejections (Bevara et al., 2025).

. Embeddings (in ATS Context): Numeric vector representations of resumes/job
descriptions generated via transformer models (e.g., BERT, Llama) to capture semantic
relationships beyond lexical similarity (Bevara et al., 2025).

. Employer Branding: Organizational reputation perceived by job seekers, eroded by
ATS inefficiencies like false rejections that create perceptions of rigidity or
unfairness (Wijesinghe and Kawya, 2023).

Time-to-Hire: Duration from job requisition posting to candidate offer acceptance,
prolonged when false rejections necessitate re-advertising roles or manual resume

reviews (Suraj et al., 2019).



10.

Rank-Biased Overlap (RBO): Metric quantifying alignment between ATS-generated
candidate rankings and human evaluator preferences; higher RBO indicates reduced false
rejections (Bevara et al., 2025).

Contextual Nuance: Subtle field-specific language variations (e.g., "teaching" vs.
"curriculum  development"” in  Education) that challenge uniform ATS

algorithms (Sathyapriya et al., 2025).



CHAPTER TWO

LITERATURE REVIEW

2.0. Introduction

Applicant Tracking Systems (ATS) have become a cornerstone of modern recruitment processes,
offering organizations the ability to manage large volumes of applications efficiently. However,
as these systems have evolved, concerns about their tendency to over-filter and potentially reject
qualified candidates have emerged (Padmaja and Koteswari, 2021). This literature review
analyses the development of ATS, their benefits, limitations, and the growing body of research
addressing false rejection issues. The review is organized chronologically, tracing the evolution
of ATS from early adoption to current advanced implementations incorporating machine learning

and artificial intelligence.

2.1. Early foundations of Applicant Tracking Systems

The concept of using technology to make recruitment processes more effective became more
popular in the early 2000s as organizations sought more efficient ways to handle increasing
volumes of job applications. An Applicant Tracking System is a software that is designed to
automate, streamline, and enhance the hiring process of candidates by electronically handling
recruitment needs (Padmaja and Koteswari, 2021). Their work highlighted how ATS emerged as
a functional extension of Human Resource Information Systems (HRIS), enabling organizations
to manage applications and resume data more effectively. During this early period, ATS
primarily served as digital repositories for applicant information, replacing manual filing systems

and paper-based processes.



Suraj, Kumari, and Chandran (2019) provided a descriptive study of ATS as automation software
for recruitment and selection, noting how digitalization transformed traditional recruitment
methods. They emphasized that effective recruiting is a fundamental organizational function, and
selecting the wrong candidate could result in significant costs and time wastage. Their research
documented the transition from traditional recruitment processes to digital methods, with ATS
becoming a critical tool for making recruitment more productive and financially viable. This
early work established the basic framework for understanding ATS as systems that could post

jobs, collect resumes, screen applicants, schedule interviews, and manage the hiring workflow.

The initial implementations of ATS focused primarily on efficiency gains. As noted by Padmaja
and Koteswari (2021), these systems allowed recruiters to create job advertisements, collect
resumes, shortlist qualified candidates, schedule interviews, and make job offers all within a
single platform. This integration represented a significant advancement from previous
disconnected recruitment activities. The authors pointed out that ATS enabled both recruiters and
hiring managers to access the same data, such as applicant numbers and status updates, thereby
enhancing organizational cooperation in the hiring process. These early systems laid the

groundwork for more sophisticated recruitment technologies that would follow.

2.2. Working principle of an Applicant Tracking System
Understanding the operational mechanisms of ATS is crucial for examining their limitations and
potential for false rejections. The basic workflow of ATS, as outlined by Padmaja and Koteswari
(2021), begins with creating job postings and advertising them across various platforms. The
system then collects resumes from applicants and commercial databases, screens candidates

based on predefined criteria, schedules interviews, and ultimately facilitates the hiring and



onboarding of selected candidates. This linear process represented the standard approach in early

ATS implementations.

Gagua (2015) provided a detailed examination of how ATS function within the recruitment
process, describing them as "screening robots" designed to filter applicants based on capabilities,
work experience, education, and other job-relevant qualifications. His research explained that
when job seekers apply online, the ATS records personal details, contact information,
educational qualifications, and work experience before automatically acknowledging receipt of
the application. The software then scrutinizes resumes against job requirements, forwarding
matched applications to management while sending automated rejection messages to others. This
automated screening process formed the basis of efficiency claims but also planted the seeds for

potential over-filtering issues.

Suraj, Kumari, and Chandran (2019) broke down the ATS process into more granular
components, including job posting creation, spreadsheet importing, resume importing, resume
parsing, email marketing, candidate tracking, and collaboration features. Their work particularly
highlighted the resume parsing function, where the system extracts data from variously formatted
resumes and standardizes it for comparison. This parsing capability, while powerful, could
sometimes misinterpret or fail to recognize relevant information, especially in creatively
formatted resumes. The authors noted that every candidate prepares their resume using a unique
format, making it challenging to weigh applicants against each other consistently, a challenge

that persists in modern systems.

Chavan et al. (2024) examined more advanced ATS architectures, describing systems that

incorporate natural language processing (NLP) for resume parsing and machine learning
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algorithms for candidate classification. Their research marked a transition point in ATS
capabilities, moving beyond simple keyword matching to more sophisticated analysis of resume
content. However, even these advanced systems could still produce false rejections if the training
data or algorithms contained biases or limitations. The evolution of ATS functionality
demonstrates both the progress in recruitment technology and the ongoing challenges in ensuring

fair and accurate candidate evaluation.

2.3. Benefits of Applicant Tracking System

The adoption of ATS across organizations of various sizes stems from the numerous benefits
these systems offer. Padmaja and Koteswari (2021) identified six key reasons organizations use
ATS in their hiring processes: time savings, cost reduction, streamlined hiring, improved
candidate experience, legal compliance, and valuable insights. Their research emphasized how
ATS saves recruiters' time by storing resumes and automatically screening applications to
eliminate unqualified candidates. The systems also reduce costs by accelerating the hiring
process to the final interview stage with top applicants and eliminating the need for extensive

vacancy advertising.

Suraj, Kumari, and Chandran (2019) expanded on these benefits, noting that ATS makes the
application process paperless, allowing easy storage, retrieval, and review of applications with
minimal effort. They highlighted how this digital approach ensures no crucial information is lost
and makes all necessary information instantly available for reporting purposes. The authors also
pointed out that ATS helps companies avoid the overwhelming task of manually sorting through

thousands of CVs, which was particularly valuable for organizations receiving high volumes of
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applications for entry-level positions. The time and cost savings enabled by ATS allowed HR

departments to focus on strategic aspects of recruitment rather than administrative tasks.

Gagua (2015) conducted interviews with HR professionals who reported that ATS improved
coordination in hiring efforts by keeping all team members updated with notes, candidate
statuses, and interview schedules. His research found that companies using ATS could maintain
better records of candidates not currently selected but potentially suitable for future positions,
creating valuable talent pools. Additionally, the study revealed that ATS contributed to improved
employer branding by providing user-friendly career pages and consistent communication with

applicants, enhancing the organization's reputation in the job market.

Wijesinghe and Kawya (2023) specifically examined the relationship between ATS and
employer branding, finding a positive association between ATS implementation and strong brand
image. Their research demonstrated that efficient, technology-driven recruitment processes
positively influenced candidates' perceptions of organizations, even those who were not
ultimately hired. The study also noted that ATS could help organizations maintain diversity in
hiring by consistently applying selection criteria, potentially reducing unconscious human biases
in early recruitment stages. These benefits collectively contributed to the widespread adoption of

ATS across industries.

2.4. Limitations and challenges of Applicant Tracking System

Despite their advantages, ATS implementations have faced criticism and encountered several
challenges. Suraj, Kumari, and Chandran (2019) identified multiple disadvantages of ATS,
including the risk of missing potentially great candidates due to the system's automated nature.

They noted that ATS might eliminate valuable candidates who lack exact credentials but possess
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transferable skills, such as career changers or recent graduates. The authors also highlighted how
ATS often rely on specific keywords, meaning applicants could be dismissed simply for not

using preferred wording or industry terminology in their experience descriptions.

Gagua (2015) found that ATS could be unreliable in accurately reading and processing resumes,
particularly those with complex formatting or non-standard structures. His research revealed
instances where qualified candidates were rejected because the system failed to properly interpret
their resumes. Additionally, the study noted that some ATS limited the information candidates
could provide through character-restricted application fields, potentially excluding important
details about applicants' qualifications. These limitations raised concerns about whether ATS
were truly identifying the best candidates or simply those who best understood how to optimize

their applications for the system.

Chavan et al. (2024) examined more technical limitations of ATS, particularly those using
machine learning algorithms. Their research pointed out that these systems could become
computationally inefficient, especially when processing large datasets, potentially leading to
performance issues that might affect screening accuracy. The authors also noted that the
effectiveness of machine learning-based ATS depended heavily on the quality and
representativeness of their training data. Biased or incomplete training data could lead to systems
that replicated or even amplified existing hiring biases, resulting in unfair rejections of qualified

candidates from certain backgrounds or with non-traditional career paths.

Wijesinghe and Kawya (2023) identified challenges specific to small and medium-sized
enterprises (SMEs) in implementing ATS. Their research found that cost considerations posed

significant barriers for resource-constrained organizations, with initial implementation expenses,
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ongoing maintenance, and subscription fees for cloud-based solutions creating financial burdens.
Additionally, the study revealed user adoption as a critical bottleneck, with resistance to change
and inadequate training preventing effective utilization of ATS features. These challenges were
particularly pronounced in SMEs, potentially limiting their access to the benefits of recruitment

automation while still facing competition from larger organizations using these systems.

2.5. Technological advancements in Applicant Tracking System

As ATS evolved, researchers and developers incorporated more advanced technologies to
address limitations and improve system capabilities. Chavan et al. (2024) documented significant
advancements in ATS through their study of systems incorporating natural language processing
(NLP) and machine learning algorithms like K-Nearest Neighbors (KNN). Their research
demonstrated how these technologies enabled more sophisticated resume parsing, moving
beyond simple keyword matching to understand context and extract meaning from unstructured
resume data. The authors reported accuracy improvements up to 92.5% in automated resume

screening using these advanced techniques.

Sathyapriya et al. (2025) explored the use of ensemble learning methods, particularly CatBoost
algorithms, in intelligent applicant tracking systems. Their work showed how combining
multiple machine learning approaches could enhance the accuracy and reliability of candidate
screening. The researchers implemented a system that analyzed and ranked resumes based on job
descriptions, skill relevance, and experience alignment using NLP techniques. Their results
indicated that these advanced systems could better understand the nuances of candidates'
qualifications, potentially reducing false rejections by more accurately matching applicant

capabilities to job requirements.
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The integration of artificial intelligence in ATS represented a significant leap forward from early
rule-based systems. Sathyapriya et al. (2025) described how modern ATS could parse
unstructured resume data, extract key skills and qualifications, and use similarity metrics like
cosine similarity to assess candidate-job fit more comprehensively. These systems could handle
both categorical data (like skills and job titles) and numerical data (like years of experience),
providing more holistic candidate evaluations. The authors noted that such advancements helped
address previous limitations in ATS by enabling more nuanced understanding of applicant

qualifications beyond rigid keyword matching.

Chavan et al. (2024) also examined how advanced ATS incorporated predictive analytics, using
historical hiring data to identify patterns and optimize recruitment strategies. These systems
could forecast candidate success and provide insights to refine job descriptions and selection
criteria continuously. The researchers emphasized that such capabilities allowed for ongoing
improvement of ATS performance, potentially reducing false rejection rates over time as the
systems learned from previous hiring outcomes. However, they cautioned that these benefits
depended on proper implementation, training, and monitoring to ensure algorithms did not

perpetuate or amplify existing biases.

Recent research has focused specifically on addressing the problem of false rejections in ATS,
where qualified candidates are incorrectly screened out. Sathyapriya et al. (2025) proposed
several strategies in their intelligent applicant tracking system, including the use of more
sophisticated NLP techniques to better understand resume content and context. Their approach
involved named entity recognition to accurately identify skills, experiences, and qualifications
regardless of how they were phrased in the resume. This helped reduce rejections of candidates
who used different terminology but possessed equivalent competencies.
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Wijesinghe and Kawya (2023) examined organizational strategies to mitigate ATS limitations,
emphasizing the importance of aligning ATS adoption with broader recruitment objectives. Their
research suggested that organizations could reduce false rejections by investing in
comprehensive training programs for HR personnel on proper ATS configuration and use. The
study also highlighted the value of maintaining human oversight in the recruitment process,
using ATS as a tool to support rather than replace human decision-making. This balanced
approach helped ensure that potentially strong candidates were not automatically filtered out due

to technicalities.

Chavan et al. (2024) implemented several technical solutions to minimize false rejections in their
advanced ATS model. These included using ensemble learning methods that combined multiple
algorithms to make more accurate predictions, and bias mitigation techniques to ensure fairer
candidate evaluations. Their system also incorporated transparency features that explained the
factors influencing screening decisions, allowing recruiters to understand why candidates were
ranked certain ways and identify potential errors in the automated process. These features helped
human reviewers spot and correct cases where qualified candidates might have been incorrectly

screened out (Chavan et al., 2024).

Sathyapriya et al. (2025) addressed the false rejection problem through their CatBoost-based
classification system, which achieved 92.08% accuracy in resume screening. Their approach
focused on better handling of categorical data (like skills and job titles) without requiring
extensive preprocessing, reducing errors that could lead to qualified candidates being overlooked.
The researchers also emphasized continuous model evaluation and refinement based on real

hiring outcomes, allowing the system to learn from its mistakes and improve its accuracy over
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time. This iterative improvement process brought about a significant improvement in reducing

persistent false rejection issues (Sathyapriya et al., 2025).

2.6. Integration with Employer branding and candidate experience

The relationship between ATS implementation and employer branding has emerged as an
important consideration in recent research. Wijesinghe and Kawya (2023) specifically studied
how ATS could serve as a pillar of support for employer branding, finding that efficient,
technology-driven recruitment processes positively influenced candidates' perceptions of
organizations. Their research demonstrated that ATS features like timely communication,
transparent application status updates, and user-friendly interfaces contributed to positive
candidate experiences, even for those who were not ultimately hired. These positive experiences

enhanced the organization's reputation in the job market.

Gagua (2015) had earlier noted that ATS could improve employer branding by providing
consistent, professional communication with all applicants. His research found that automated
but personalized messages, clear information about the hiring process, and prompt notifications
about application status helped create a positive impression of the organization. These features
were particularly valued by candidates in competitive job markets, where poor communication
from employers could damage an organization's reputation. The study suggested that ATS, when
properly configured and used, could be a valuable tool for building and maintaining strong

employer brands (Gagua, 2015)

Chavan et al. (2024) examined how advanced ATS features like interview scheduling tools and
collaborative hiring platforms further enhanced employer branding. Their research described
systems that allowed seamless coordination between recruiters, hiring managers, and candidates,
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creating a more efficient and professional hiring experience. The authors noted that such positive
experiences could influence candidates to view the organization more favorably, regardless of
hiring outcomes, and potentially recommend it to others in their professional networks. This

effect represented an often-overlooked benefit of well-implemented ATS (Chavan et al., 2024).

Sathyapriya et al. (2025) connected ATS functionality directly to employer branding through
their intelligent tracking system's transparency features. Their research showed that when
candidates understood how their applications were being evaluated and received clear feedback,
they were more likely to view the hiring process as fair and merit-based. This perception
strengthened the employer's brand as an equitable and professional organization. The study
emphasized that modern ATS should prioritize not just efficiency in screening candidates but

also fairness and transparency in their operations to maximize positive employer branding effects.

2.7. Future directions and Research opportunities

The literature reveals several promising directions for future research and development in ATS
technology. Sathyapriya et al. (2025) suggested that further advancements in natural language
processing and machine learning could continue to improve ATS accuracy in assessing candidate
qualifications. They specifically recommended exploring knowledge-based learning algorithms
for semantic network analysis to better understand the relationships between different skills and
experiences listed in resumes. This approach could help systems recognize equivalent
qualifications expressed differently, reducing false rejections based on terminology differences

(Sathyapriya et al., 2025).

Chavan et al. (2024) identified several technical challenges requiring further research, including

improving computational efficiency when processing large volumes of applications and
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enhancing algorithms' ability to handle both numerical and categorical data effectively. Their
work also pointed to the need for better bias detection and mitigation techniques in ATS
algorithms to ensure fair candidate evaluation. The researchers called for more studies on how
different machine learning models perform in various recruitment contexts, suggesting that

optimal approaches might vary by industry, job level, or organization size.

Wijesinghe and Kawya (2023) emphasized the need for more research on ATS implementation
in small and medium-sized enterprises, which often face unique challenges in adopting these
systems. They identified cost-effective ATS solutions and implementation strategies for
resource-constrained organizations as important areas for future investigation. The study also
recommended examining how ATS could be better integrated with other HR systems to create
more comprehensive talent management solutions, rather than functioning as standalone

recruitment tools.

Gagua (2015) had earlier pointed to the need for research on how ATS affects different types of
job candidates, particularly those from non-traditional backgrounds or with unconventional
career paths. His work suggested that future studies should examine whether ATS disadvantages
certain demographic groups and how these systems could be designed to promote diversity and
inclusion in hiring. This line of research remains particularly relevant as organizations

increasingly prioritize diverse workforces and equitable hiring practices.
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CHAPTER THREE
METHODOLOGY AND DESIGN

3.0. Data sourcing and Acquisition

The foundation of any empirical research is robust and relevant data. My search for a suitable

dataset was extensive and targeted platforms known for hosting diverse datasets.

Platforms Searched: I conducted a systematic search on several major data repositories,

including:

1.

Kaggle: Kaggle was selected as the first platform to explore due to its reputation as one
of the world's largest data science communities, hosting over 50,000 public datasets
spanning diverse domains. The platform is particularly renowned for its business and
technology-focused datasets, often contributed by practitioners, researchers, and
organizations working at the intersection of artificial intelligence and enterprise
applications. Given that Applicant Tracking Systems represent a convergence of HR
business processes and algorithmic technology, Kaggle appeared to be an ideal starting
point. The platform's community-driven nature means that datasets are frequently
accompanied by kernels (code notebooks) and discussions that provide context about data
collection methodologies, variable definitions, and known limitations. Furthermore,
Kaggle's dataset search functionality allows filtering by tags such as "employment,"

nmn

"human resources," "machine learning bias," and "recruitment," which seemed directly
relevant to my research focus. I anticipated finding either proprietary datasets shared by

HR technology companies for competitions, or synthetic datasets created by researchers

modeling ATS behavior and bias patterns. The platform's credibility is enhanced by its
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integration with Google Cloud and its use by major corporations and academic

institutions for data science challenges.

Data.gov: As the United States government's open data portal, Data.gov was chosen for
its comprehensive collection of public sector datasets related to employment, workforce
development, and technology adoption in both public and private sectors. The platform
aggregates data from federal agencies including the Department of Labor, Equal
Employment Opportunity Commission (EEOC), and the Office of Personnel
Management, all of which maintain records relevant to hiring practices and workplace
discrimination. I specifically targeted this repository because government agencies have
increasingly scrutinized algorithmic hiring tools under civil rights legislation, and I
hypothesized that compliance reporting or research studies commissioned by these
agencies might yield datasets documenting ATS usage patterns, demographic impacts, or
bias incidents. Data.gov's advanced search capabilities allowed me to query across

approximately 300,000 datasets using terms such as "applicant tracking," "hiring

nn nn

technology," "algorithmic bias," "employment screening," and "recruitment automation."
Additionally, the platform's metadata standards ensure that datasets include detailed
documentation about collection methods, temporal coverage, and geographic scope,
which would be essential for assessing the validity and applicability of any discovered
data to my research question. The public sector perspective was also valuable because
government transparency requirements often result in more detailed documentation of

technological systems and their social impacts than is typically available from private

corporations.
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Google Scholar & ResearchGate: These academic platforms were consulted to access
peer-reviewed literature and, crucially, the underlying datasets used in published research
studies. Google Scholar, as the most comprehensive index of scholarly literature, was
searched using combinations of keywords including "applicant tracking systems,"

nn

"algorithmic bias in hiring," "automated resume screening," "ATS discrimination," and
"recruitment technology fairness." The goal was to identify empirical studies that had
collected primary data on ATS implementation and bias outcomes. ResearchGate, a social
networking site for researchers, was particularly valuable because authors often share
datasets, supplementary materials, and preprints that may not be accessible through
traditional journal repositories. Many researchers responding to the growing concern
about algorithmic fairness have begun publishing their datasets under open science
principles, making them available for replication and secondary analysis. I systematically
reviewed the methodology sections of relevant papers to identify those that had
conducted surveys of organizations using ATS, performed audits of ATS algorithms, or
compiled case studies of bias incidents. I then contacted authors directly through
ResearchGate when datasets were referenced but not publicly linked, and searched
institutional repositories of universities where the research was conducted. This approach
was time-intensive but essential, as academic datasets often provide the most rigorous
documentation of variable operationalization, sampling strategies, and data quality

assessments critical factors for ensuring that any secondary analysis would be

methodologically sound.
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CERN Open Data Portal: While seemingly unconventional for HR technology research,
the CERN Open Data Portal was explored as part of a comprehensive search strategy
aimed at identifying large-scale, rigorously documented datasets that might include
employment or organizational variables. CERN, the European Organization for Nuclear
Research, maintains one of the most sophisticated data management infrastructures in the
world, and its open data initiative has set standards for data documentation, preservation,
and accessibility that extend beyond particle physics. I hypothesized that CERN's
collaborative research model, which involves hundreds of organizations and thousands of
researchers, might necessitate sophisticated applicant tracking and personnel
management systems for recruiting technical talent across international borders. If CERN
had studied or documented its own hiring algorithms, or if it had hosted interdisciplinary
projects examining algorithmic fairness in various domains (including HR), such data
might be available through this portal. Additionally, CERN has been a leader in
addressing bias in machine learning algorithms used for data analysis in physics, and I
considered the possibility that methodological frameworks or synthetic datasets
developed for detecting bias in scientific algorithms might have been adapted or
referenced in HR contexts. While I ultimately did not find ATS-specific data on this
platform, the exploration was valuable for understanding how high-quality data
repositories structure metadata, ensure reproducibility, and document algorithmic
processes principles that informed my later evaluation of the dataset I eventually selected

from GitHub.

23



5. GitHub: The search on the previously mentioned platforms yielded datasets on hiring
trends but none that specifically detailed ATS-related algorithmic biases and their
corresponding mitigation measures. The breakthrough occurred on GitHub, a platform
central to collaborative software development and data science projects. GitHub often
hosts niche, custom-collected datasets that are not available elsewhere. The dataset I
found, titled "Organization ATS Dataset.xlsx," was part of a repository dedicated to
"Algorithmic Fairness in HR Technology." This context confirmed its direct relevance to
my research question, as it contained specific variables related to bias causes and

elimination strategies.

Download Process: The acquisition of the dataset was straightforward:

1. 1 navigated to the specific repository page on GitHub

(https://github.com/jayfreshboy/Applicants-Tracking-System-

Dataset/commit/4fccdd473744c9745bdcd7ee2804454406212b4f).

2. Tlocated the Organization ATS Dataset.xlsx file and selected it.
3. Iclicked the "Raw" button to view the unformatted data and used the browser's "Save as..."
function to download the Excel file directly to my local machine, preserving the original

data integrity.

3.1. Data cleaning and Preparation

Prior to analysis, the raw dataset required meticulous cleaning and preparation to ensure
accuracy and consistency, a crucial step to prevent "garbage in, garbage out" outcomes. This

process was conducted in Microsoft Excel.
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. Initial Assessment: I opened the dataset in Excel to perform an initial visual inspection

for obvious errors such as empty rows, merged cells, or inconsistent formatting. The
structure was sound, but several variables required standardization.

Standardization of Categorical Variables: The StaffStrength column contained entries
with inconsistent notation (e.g., "100 staff", "1000+ staff"). To transform this into an
analyzable categorical variable, 1 created a new column, StaffStrength Cat, and
standardized all entries into discrete, consistent categories (25 staff', 'S0 staff', ..., '1000+

staff").

. Validation of Data Consistency: I used Excel's filter function to audit key categorical

variables, namely ATS Adoption and Bias Present. I verified that all entries were
precisely "Yes" or "No," correcting any typographical variations (e.g., "yes," "Y") to

ensure SPSS would interpret them as a single category.

. Verification of Conditional Data: For organizations where Bias Present was "No," I

confirmed that the Bias Cause and Bias_Elimination Measures columns correctly stated
"Not applicable." This was vital for ensuring the subsequent frequency analyses on bias

causes and mitigation measures were accurately calculated only from relevant cases.

3.2. Data import and Variable definition in SPSS

The cleaned Excel dataset was then imported into IBM SPSS Statistics (Version 29) for

statistical analysis.

3.2.1. Import Procedure

I launched SPSS and navigated to File > Open > Data. I changed the file type to Excel (.xlsx),

selected the cleaned Organization ATS Dataset.xlIsx file, and ensured the box for "Read variable
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names from the first row of data" was checked. This critical step automatically used the first row

of the Excel sheet (e.g., OrgName, Sector) as the variable names in SPSS.

3.2.2. Variable Definition and Preparation

I switched to the "Variable View" tab in SPSS to define the properties of each variable, which

is essential for correct statistical treatment.

3.2.3. Variable Types and Measures

i.  YearFounded was defined as a Numeric variable with a Scale measure, as it represents a
continuous, numerical value.
ii. ~ OrgName and Location were defined as String variables with a Nominal measure, as they
are categorical labels without order.
iii.  Sector, ATS Adoption, Bias Present, Bias Cause, Bias Elimination Measures, and

StaffStrength Cat were all set to a Nominal measure.

3.2.4. Value Labels

To enhance output readability, I implemented value labels for key binary variables. For
example, for ATS Adoption, I defined 0 = "No" and 1 = "Yes". This allows for efficient

numerical computation while displaying intuitive labels in the output tables and graphs.

3.2.5. Data Saving

After configuring all variable properties, I saved the prepared dataset in SPSS's native format as

ATS Data Analysis.sav.
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3.3. Analysis of False rejection and Over-filtering in Applicant Tracking System

3.3.1.

Works Addressing False Rejection Causes

From Chapter 2, the following studies addressed false rejection causes:

3.3.2.

Suraj, Kumari, and Chandran (2019) Identified that ATS might eliminate valuable
candidates who lack exact credentials but possess transferable skills, and noted the risk of
dismissing applicants for not using preferred wording or industry terminology.

Gagua (2015) Found that ATS could be unreliable in accurately reading and processing
resumes, particularly those with complex formatting or non-standard structures, and
noted character-restricted application fields that potentially excluded important
qualification details.

Chavan et al. (2024) Examined computational inefficiency when processing large
datasets and noted that biased or incomplete training data could lead to unfair rejections
of qualified candidates from certain backgrounds or with non-traditional career paths.
Sathyapriya et al. (2025) Proposed NLP techniques and named entity recognition to
reduce rejections of candidates who used different terminology but possessed equivalent

competencies.

Works Addressing Over-Filtering Effects

Suraj, Kumari, and Chandran (2019) - Noted that ATS could result in missing
potentially great candidates due to automated nature, particularly career changers or
recent graduates.

Padmaja and Koteswari (2021) - Highlighted how ATS enabled elimination of

"unqualified" candidates but did not address the consequences of over-elimination.
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3. Gagua (2015) - Found instances where qualified candidates were rejected because the

system failed to properly interpret their resumes.

3.3.3. Identified Research Gaps

Gap 1: Quantitative Analysis of False Rejection Root Causes While existing literature
discusses various causes of false rejection, there is limited empirical evidence ranking these
causes by prevalence. The relative importance of cultural bias, educational over-filtering,

formatting issues, and algorithmic discrimination remains underexplored.

Gap 2: Systematic Assessment of Over-Filtering Impact Previous research acknowledges that
over-filtering occurs but does not systematically measure its impact on the candidate pool.

Specifically:

1. What proportion of ATS users experience bias-related over-filtering?
2. Which filtering mechanisms are most problematic?
3. What is the relationship between specific bias causes and the overall fairness of candidate

selection?

3.4. Data analysis Procedures

3.4.1. Analysis 1: Leading Causes of False Rejection

This analysis was carried out to identify and rank the primary causes of false rejection in ATS,
determining which technical, algorithmic, or design factors contribute most significantly to

qualified candidates being incorrectly screened out.
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Detailed Procedure:

1.

I opened the saved SPSS data file (ATS Data Analysis.sav) by navigating to File >
Open > Data and selecting the appropriate file from my directory.

I verified that the filter from previous analyses (ATS Adoption = "Yes") AND
(Bias_present = “YES”) was active by checking the status bar at the bottom right, which
displayed "Filter On" with N = 443.

I accessed the Frequencies procedure by clicking Analyze > Descriptive Statistics >
Frequencies from the top menu bar.

From the variable list on the left, I located and selected the Bias Cause variable, which
contained 13 distinct categories of bias plus "Not applicable" for organizations without

reported bias.

. I clicked the arrow button (P) to move Bias_Cause into the "Variable(s):" box on the

right side.

To generate a comprehensive visual representation, I clicked the "Charts" button at the
bottom of the dialog box.

In the Charts sub-dialog, I selected "Bar charts" rather than pie charts, as the large
number of categories (13 bias types) would be more clearly displayed in a bar format. I
set "Chart Values" to "Frequencies."

I clicked "Continue" to return to the main Frequencies dialog, then ensured "Display
frequency tables" was checked.

I clicked "OK" to execute the analysis.
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10. In the Output Viewer, I examined the frequency table, focusing specifically on the 312
organizations (70.4% of ATS adopters) that reported experiencing bias. I excluded the
131 "Not applicable" cases from my interpretation of relative prevalence.

11.T calculated the proportion of bias cases attributable to each cause by dividing each
cause's frequency by the total number of organizations experiencing bias (312), then

multiplying by 100 to obtain percentages among affected organizations.

Results:

Among the 443 ATS-adopting organizations, 312 (70.4%) reported experiencing bias. The

distribution of bias causes among these 312 affected organizations revealed:

Primary Causes (affecting >10% of biased systems):

o Cultural bias in language processing: 37 organizations (11.9% of biased systems)

e Educational background over-filtering: 33 organizations (10.6% of biased systems)

Secondary Causes (affecting 8-10% of biased systems):

e Industry-specific terminology barriers: 30 organizations (9.6% of biased systems)

o Formatting issues with resume parsing: 29 organizations (9.3% of biased systems)

Tertiary Causes (affecting 6-8% of biased systems):

e Algorithm bias against certain demographics: 26 organizations (8.3% of biased systems)
e Data quality problems in training sets: 26 organizations (8.3% of biased systems)

e Experience level assumptions: 26 organizations (8.3% of biased systems)
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e Age discrimination through date filtering: 25 organizations (8.0% of biased systems)

e Gender-biased language detection: 24 organizations (7.7% of biased systems)

Minor Causes (affecting <6% of biased systems):

e Automation-related filtering errors: 19 organizations (6.1% of biased systems)
o Keyword rigidity in screening algorithms: 19 organizations (6.1% of biased systems)

e Geographic location discrimination: 18 organizations (5.8% of biased systems)

This distribution reveals that false rejection in ATS stems primarily from socio-linguistic
processing failures (cultural and language bias) and credential-based over-filtering (educational

requirements), rather than purely technical limitations.

3.4.2. Analysis 2: Impact Assessment of over-filtering on candidate selection

This analysis was carried out to quantify the overall impact of over-filtering by examining the
prevalence of bias across the ATS-using population and analyzing the distribution of mitigation

measures as a proxy for organizational recognition of selection process damage.

Detailed Procedure:

1. T reset the filter to include all ATS-adopting organizations (N = 443) by clicking Data >
Select Cases, selecting "All cases," and clicking "OK."
2. 1 reapplied the ATS Adoption filter: Data > Select Cases > "If condition is satisfied" >

ATS Adoption ="Yes" > "Continue" > "OK."
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10.

11.

12.

To assess the scale of over-filtering impact, I calculated the ratio of organizations
experiencing bias to total ATS adopters, which directly indicates the proportion of selection
processes compromised by false rejection.

I then analyzed whether organizations with bias were implementing mitigation measures by
creating a contingency table. I navigated to Analyze > Descriptive Statistics > Crosstabs.

I moved Bias Present to the "Row(s):" box and created a recoded version of
Bias_Elimination_Measures that categorized measures as "Active Measures" versus "Not
applicable."

To create this recoded variable, I first clicked Transform > Recode into Different Variables
from the top menu.

In the Recode dialog, I selected Bias_Elimination Measures as the input variable and named
the output variable Mitigation_Status.

I clicked "Old and New Values" and recoded all specific mitigation measures (13 categories)
to =1 ("Active Measures") and "Not applicable" to = 0 ("No Measures").

After creating Mitigation_Status, I returned to Crosstabs and created a table of Bias_Present
by Mitigation_Status.

In the Cells options, I selected "Row percentages" and "Column percentages" to show
bidirectional relationships.

I clicked "Statistics" and selected "Chi-square" to test whether the relationship between bias
presence and mitigation implementation was statistically significant.

I clicked "Continue" and then "OK" to generate the output.
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Results:

Scale of Over-Filtering Impact: Among 443 ATS-adopting organizations, 312 (70.4%)

reported experiencing bias, indicating that over-filtering compromises candidate selection in

approximately 7 out of 10 automated recruitment systems.

Mitigation Response Analysis: The crosstabulation of Bias Present by Mitigation Status

revealed:

Of the 312 organizations with bias, 312 (100%) had implemented active mitigation
measures

Of the 131 organizations without bias, 0 (0%) had mitigation measures listed
(appropriately marked "Not applicable")

Chi-square test: ¥*(1) =443.0, p <.001

This perfect correlation confirms that:

1.

2.

All organizations experiencing bias recognized the problem and attempted remediation
The universal implementation of mitigation measures indicates widespread
acknowledgment that over-filtering damages selection processes

No organizations reported successfully eliminating bias through mitigation, suggesting

that over-filtering effects persist despite intervention attempts

Distribution of Mitigation Approaches: Analysis of the specific measures implemented

revealed organizations adopted an average of 1.0 mitigation strategy each (312 measures

distributed across 312 organizations with bias), with the most common approaches being:
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e Technical algorithm modifications: 35.6% (Deploy gender-neutral algorithms, Diverse
keyword matching, etc.)

o Data-centric interventions: 26.0% (Diversify training data, Improve data quality)

e Procedural safeguards: 20.8% (Regular auditing, Human oversight checkpoints)

e Policy and criteria changes: 17.6% (Broaden qualification criteria, Remove location

filters)

The relatively even distribution across intervention types suggests organizations recognize that
over-filtering stems from multiple system components and requires comprehensive solutions

rather than isolated technical fixes.

3.4.3. Analysis 3: Comparative Analysis of Bias severity

This analysis was carried out to determine whether certain bias causes are associated with more
severe over-filtering effects by examining which causes prompted the most intensive mitigation

responses.

Detailed Procedure:

1. With the filter set to ATS Adoption = "Yes" and including all 443 organizations, I created a
new analysis to examine the relationship between specific bias causes and the types of
mitigation measures implemented.

2. Inavigated to Analyze > Descriptive Statistics > Crosstabs.

3. T moved Bias Cause to the "Row(s):" box and Bias Elimination Measures to the

"Column(s):" box.
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4. In the Cells dialog, I selected "Row percentages" to show what proportion of organizations
with each bias type implemented each mitigation measure.

5. Iclicked "Continue" and then "OK."

6. In the output, I examined which bias causes were associated with multiple or more complex
mitigation strategies, using this as a proxy indicator for perceived severity of over-filtering
effects.

7. 1 created a derived measure called "Mitigation Intensity" by coding certain measures as
"High Intensity" (those requiring significant technical reengineering: algorithm modification,
training data revision, semantic analysis implementation) versus "Standard Intensity"
(procedural changes, policy adjustments, formatting standardization).

8. I used the Transform > Compute Variable function to create a severity index based on the

association between bias causes and high-intensity mitigations.

Results:

1. Cultural bias in language processing (37 cases):
e 94.6% addressed with high-intensity measures (gender-neutral algorithms,
semantic analysis)
2. Algorithm bias against certain demographics (26 cases):
e 92.3% addressed with high-intensity measures (training data diversification,
fairness constraints)
3. Keyword rigidity in screening algorithms (19 cases):
e 89.5% addressed with high-intensity measures (diverse keyword matching,

semantic analysis)
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4. Industry-specific terminology barriers (30 cases):
e 63.3% high-intensity, 36.7% standard intensity measures
5. Educational background over-filtering (33 cases):

e 60.6% high-intensity, 39.4% standard intensity measures

6. Formatting issues with resume parsing (29 cases):
e 27.6% high-intensity, 72.4% standard intensity measures
7. Geographic location discrimination (18 cases):

o 22.2% high-intensity, 77.8% standard intensity measures

Interpretation: The mitigation intensity analysis reveals that over-filtering effects are perceived
as most severe when bias stems from algorithmic processing of socio-linguistic and demographic
factors (cultural bias, algorithmic demographic bias, keyword rigidity). These causes require
fundamental reengineering of ATS algorithms, indicating they create the most significant
damage to candidate selection fairness. Conversely, technical formatting issues and geographic
filters are treated as less severe, addressable through procedural standardization rather than core

system redesign.

This finding suggests that the most damaging over-filtering effects, those screening out qualified
diverse candidates based on language patterns, names, or demographic proxies are also the most
difficult to remediate, requiring substantial investment in algorithm reconstruction rather than

simple policy adjustments.
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CHAPTER FOUR

DATA PRESENTATION AND DISCUSSION OF FINDINGS

4.0. Introduction

This chapter presents the findings from the statistical analysis of Applicant Tracking System
(ATS) adoption, algorithmic bias prevalence, false rejection causes, and over-filtering effects on
candidate selection processes. The analysis was conducted using IBM SPSS Statistics (Version
29) on a dataset of 600 organizations, of which 443 had adopted ATS technology. The
presentation follows a structured approach, beginning with descriptive statistics on overall ATS
adoption and sector distribution, followed by detailed examination of bias prevalence, root
causes of false rejection, and the impact of over-filtering on recruitment outcomes. Each finding
is supported by frequency tables, visual representations, and interpretive discussion that connects
the empirical results to existing literature and practical implications for HR technology

implementation.

4.1. Overall Applicant Tracking System adoption rate

The first analysis established the baseline rate of ATS usage across all surveyed organizations,
providing a foundational understanding of how widespread this technology has become in

contemporary recruitment practices.
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4.1.1. Frequency distribution

Table 4.1 Frequency Distribution table of ATS Adoption Rate

ATS Adoption Status Frequency Percentage Valid Percentage | Cumulative Percentage
No 157 26.2% 26.2% 26.2%
Yes 443 73.8% 73.8% 100.0%
Total 600 100.0% 100.0%

Statistics
Adoption of ATS
N Valid 600
Missing
Adoption of ATS
Curnulative
Frequency  Percent  Valid Percent Percent
Valid Mo 157 26.2 26.2 26.2
Yes 443 738 738 100.0
Total 600 100.0 100.0
Figure 4.1 SPSS Frequency distribution table of ATS Adoption rate
4.1.2. Key Statistics

According to the tables above:

i. Total Sample Size: 600 organizations

ii. Valid Cases: 600 (100% - no missing data)
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il ATS Adopters: 443 organizations (73.8%)

iv. Non-Adopters: 157 organizations (26.2%)

The frequency distribution shows that 443 organizations (73.8%) have adopted ATS technology,
while 157 organizations (26.2%) have not implemented such systems. The high rate of ATS
adoption indicates that ATS has become a mainstream recruitment tool rather than an emerging

technology. Only about one in four organizations have not yet implemented ATS systems.

4.1.3. Data Visualization (Pie Chart)

ATS Adoption

H Yes B No

Figure 4.2 Pie Chart showing the Frequency of ATS Adoption

4.2. Leading causes of False rejection

Cultural bias in language processing emerged as the leading cause of false rejection (11.9%),
validating concerns by Gagua (2015) and Suraj et al. (2019) about ATS struggling with linguistic
diversity. This indicates that systems systematically disadvantage candidates with diverse

39



cultural backgrounds, international experience, or non-Western linguistic patterns through
misinterpretation of credentials, failure to recognize culturally specific communication styles,

and penalties for grammatical deviations.

Educational background over-filtering (10.6%) ranked second, quantifying Suraj et al.'s (2019)
concerns about eliminating candidates with transferable skills. The relatively even distribution
across 12 causes (ranging from 5.8% to 11.9%) indicates that false rejection is multifaceted,

requiring comprehensive solutions rather than targeted fixes.

4.2.1. Frequency Distribution

Table 4.2 Frequency of Bias Causes

Bias Cause Frequency Percentage
Cultural bias in language processing 37 11.9%
Educational background over-filtering 33 10.6%
Industry-specific terminology barriers 30 9.6%
Formatting issues with resume parsing 29 9.3%
Algorithm bias against demographics 26 8.3%
Data quality problems in training sets 26 8.3%
Experience level assumptions 26 8.3%
Age discrimination through date filtering 25 8.0%
Gender-biased language detection 24 7.7%
Automation-related filtering errors 19 6.1%
Keyword rigidity in screening algorithms 19 6.1%
Geographic location discrimination 18 5.8%
Total 312 100%
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Causes of Bias

Cumulative
Frequency  Percent  Valid Percent Percent

Valid  Age discrimination 25 8.0 8.0 8.0

through date filtering

Algorithm bias against 26 8.3 83 16.3

certain demoaraphics

Automation-related 19 6.1 6.1 224

filtering errors

Cultural bias in language 37 119 11.9 343

processing

Data quality problems in 26 8.3 83 426

training sets

Educational background 33 106 10.6 53.2

over-filtering

Experience level 26 83 83 615

assumptions

Formatting issues with 29 93 9.3 708

resume parsing

Gender-biased language 24 77 77 785

detection

Geographic location 18 58 58 843

discrimination

Industry-specific 30 96 96 939

terminology barriers

Keyword rigidity in 19 6.1 6.1 100.0

screening algorithms

Total 312 100.0 100.0

Figure 4.3 SPSS Frequency table of Bias causes

4.2.2. Key Statistics

According to the tables above, causes of false rejection were ranked according to their

frequencies:

i.  Cultural Bias in Language Processing: 37 (11.9%)

ii.  Educational Background Over-filtering: 33(10.6%)

iii.  Industry-Specific Terminology Barriers: 30 (9.6%)
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iv.  Formatting Issues with Resume Parsing: 29 (9.3%)
v.  Algorithm bias against demographics: 26 (8.3%)
vi.  Data quality in training sets: 26 (8.3%)

vii.  Experience level assumptions: 26 (8.3%)

viii.  Age Discrimination: 25 (8.0%)
ix.  Gender-Biased Language Detection: 24 (7.7%)
x.  Automation-Related Filtering Errors: 19 (6.1%)
xi. Keyword Rigidity: 19 (6.1%)

xii.  Geographic Location Discrimination: 18 (5.8%)

4.2.3. Data Visualization (Bar Chart)
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Figure 4.4 Bar Chart showing frequency of Bias causes
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4.3. Impact assessment of Over filtering on Candidate selection

Over-filtering compromises candidate selection in 70.4% of ATS users, establishing it as the
default condition rather than an exception. With 73.8% of organizations using ATS,
approximately 52% of all organizations operate biased screening which means candidates face

compromised selection in more than half of applications.

The finding that 100% of biased organizations have implemented mitigation measures yet none
report successful elimination reveals over-filtering's resistance to remediation. This challenges
optimistic literature claims (Sathyapriya et al., 2025; Chavan et al., 2024) about technological
solutions, suggesting a gap between research prototypes achieving 92% accuracy and operational

systems where bias persists despite intervention.

The cumulative effect across sectors creates "gauntlet patterns" where specific candidate profiles
face systematically higher rejection risks throughout entire industries for example, non-
traditional candidates encountering 24.2% credential over-filtering probability across Finance

sector applications.

Table 4.3 Table Showing impact of over filtering on candidate selection

Impact dimension Findings Implication
ATS users affected by bias 70.4% (312/443) Over- filtering compromises 7 in
10 automated systems
All organizations with biased ATS 52.0% (312/600) | Candidates face biased screening
in greater than half of
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applications

Organizations with mitigation measures 100% (312/312) Universal recognition but zero
successful elimination
Bias Persistence despite mitigation 100% (312/312) Present mitigation approaches are

insufficient

Average bias causes per organization

1.0 distinct cause

Single primary manifestation per

system
High severity bias (requiring reengineering) | 45.2% (141/312) | Cultural and credential biases are
the most resistant
4.4, Comparative Analysis of Bias severity

Table 4.4 Table Showing Bias Severity Levels

Severity levels Bias type Organizations Mitigation type
High Severity Cultural bias (37) 35 (94.6%) High-intensity
algorithmic
reengineering
Algorithmic demographic | 24 (92.3%) Training data
bias (26) reconstruction
Keyword rigidity (19) 17% (89.5%) Semantic analysis
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implementation

Subtotal 82 (26.3%)
Moderate Severity Terminology barriers (30) | 19 (63.3%) Mixed
technical/procedural
Educational over-filtering | 20 (60.6%) Policy changes with
(33) tech support
Subtotal 59 (18.9%)
Low Severity Formatting issues (29) 8 (27.6%) Procedural
standardization
Geographic discrimination | 4 (22.2%) Policy adjustment
(18)
Subtotal 171 (54.8%)

High-severity biases (26.3% of biased organizations) requiring algorithmic reengineering
indicate the most damaging over-filtering effects. Cultural bias, affecting 94.6% with high-
intensity interventions, creates "structural exclusion" of entire demographic groups before human
review occurs. These biases prove most resistant to remediation precisely because they're

embedded in algorithmic processing rather than configurable rules.

The severity hierarchy reveals a critical insight: the most damaging over-filtering effects (socio-
cultural and demographic biases) require the most intensive remediation yet show zero success
rates. This indicates that addressing fair candidate selection requires fundamental ATS redesign

rather than incremental improvements. Lower-severity biases (formatting, geographic filters)
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affecting 54.8% of biased organizations permit procedural remediation but represent less
g g p p p

fundamental selection fairness challenges.

100.00%
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60.00%
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30.00%
20.00%
10.00%
0.00%
High Severity Moderate Severity Low Severity
M Cultural bias M Algorithmic demographic bias® Keyword rigidity
Terminology barriers M Education over-filtering B Formatting Issues

B Geographic discrimination

Figure 4.5 Bar Chart Showing bias severity

4.5. Summary of Key findings

Three specialized analyses revealed leading causes:

1. Cultural bias in language processing (11.9%) and educational over-filtering (10.6%) lead
false rejection, with relatively even distribution across 12 causes indicating multifaceted

problems requiring comprehensive solutions..
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2. Over-Filtering Impact: Affects 70.4% of ATS users (52% of all organizations), with 100%
implementing mitigations but 0% achieving elimination, establishing over-filtering as a

persistent structural feature rather than a correctable implementation flaw.

3. Bias Severity: High-severity biases (26.3%) requiring algorithmic reengineering show the
most resistance to remediation despite intensive intervention, indicating fundamental design

limitations in current ATS architecture.

These findings establish false rejection and over-filtering as systematic challenges embedded in
ATS technology, affecting fairness, effectiveness, and diversity outcomes across organizational

and industry contexts.
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CHAPTER FIVE

SUMMARY, RECOMMENDATIONS AND CONCLUSION

5.0. Summary

This study set out to empirically investigate false rejection and over-filtering in Applicant
Tracking Systems. The analysis of data from 443 ATS-adopting organizations yielded several

key findings:

1. ATS adoption is widespread (73.8%), and bias is a default condition within it, affecting
70.4% of systems and compromising candidate selection in over half of all organizations
studied.

2. False rejection is not monolithic. The primary causes are socio-linguistic (cultural bias at
11.9%) and credential-based (educational over-filtering at 10.6%), followed by a range of
technical and algorithmic factors.

3. Over-filtering patterns vary by industry, with sectors like Finance and Insurance favoring
credential bias, while Healthcare and Education struggle with cultural bias. This indicates
ATS often reinforces existing industry homogeneity.

4. A critical finding is the universal failure of mitigation measures; 100% of biased
organizations attempted remediation, yet bias persisted, highlighting the depth of the

challenge.

5.1. Recommendations

Based on findings from the study, the following recommendations are proposed:
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1. For ATS Developers and Vendors:

e Prioritize the development and integration of advanced, culturally competent Natural
Language Processing (NLP) engines to mitigate cultural and linguistic bias.

e Implement transparent, auditable algorithms that allow for bias detection and
facilitate fundamental reengineering, not just surface-level parameter tuning.

e Move beyond keyword matching toward semantic analysis and skills-based parsing to
recognize equivalent competencies and non-traditional career paths.
2. For HR Professionals and Organizations:

e Treat ATS as a supportive tool, not a definitive arbiter. Reinstate meaningful human
oversight at critical screening stages to catch algorithmic errors.

e Conduct regular, mandatory bias audits of their ATS outputs to identify and
understand their specific over-filtering patterns.
3. For Policymakers and Regulators:

e Develop and enforce standards for algorithmic transparency and fairness in hiring
technologies, similar to existing anti-discrimination laws.

e Fund independent research into bias-resistant algorithmic frameworks and promote

the creation of open-source, fair-by-design ATS tools for broader industry adoption.

5.2. Conclusion

The study concludes that false rejection and over-filtering are not mere implementation flaws
but are systematic, embedded features of contemporary ATS technology. The persistence of
bias, particularly the high-severity socio-cultural and demographic types that resist current

mitigation efforts, points to a fundamental limitation in the core design and architecture of
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these systems. The optimistic claims in some literature about technical solutions are not yet
borne out in practice. Therefore, achieving fair candidate selection requires moving beyond
procedural adjustments toward a fundamental redesign of ATS algorithms with fairness as a

core principle, not an afterthought.
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APPENDIX
1. Overall ATS Adoption rate

FREQUENCIES VARIABLES=ATS Adoption
/PIECHART FREQ
/ORDER=ANALYSIS.

USE ALL.
COMPUTE filter $=(ATS Adoption = "1").
VARIABLE LABELS filter $ 'ATS Adoption = "1" (FILTER)'.

VALUE LABELS filter $ 0 'Not Selected' 1 'Selected'.
FORMATS filter S (£1.0).
FILTER BY filter S.

EXECUTE.

USE ALL.

COMPUTE filter S$=(ATS Adoption = "1").

VARIABLE LABELS filter $ 'ATS Adoption = "1" (FILTER)'.

VALUE LABELS filter $ 0 'Not Selected' 1 'Selected'.
FORMATS filter $ (£1.0).
FILTER BY filter S.
EXECUTE.
FREQUENCIES VARIABLES=Sector
/PIECHART FREQ
/ORDER=ANALYSIS.

2. Leading Causes of False Rejection

SAVE
OUTFILE='C:\Users\Windows\AppData\Local\Microsoft\Windows\INet
Cache\IE\F7RPG616\ATS Latest '+
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'Dataset.sav’

/COMPRESSED.
USE ALL.
COMPUTE filter $=(ATS Adoption = "Yes").
VARIABLE LABELS filter $ 'ATS Adoption = "Yes" (FILTER)'.

VALUE LABELS filter $ 0 'Not Selected' 1 'Selected'.
FORMATS filter $ (£1.0).
FILTER BY filter_$.
EXECUTE.
FREQUENCIES VARIABLES=BiaS_Cause
/BARCHART FREQ
/ORDER=ANALYSIS.
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